## Table of Contents

**Web Browsing Basics** .............................................................................................................. 7
  Introduction to the Internet ........................................................................................................ 8
  Understanding the Internet Explorer Window ............................................................................ 9
  What's New in Internet Explorer 8 ............................................................................................. 10
  Starting Internet Explorer .......................................................................................................... 11
  Displaying a Specific Web Page ................................................................................................. 12
  Browsing the Web ...................................................................................................................... 13
  Browsing with Tabs .................................................................................................................... 15
  Searching the Web with a Search Engine .................................................................................. 17
  Searching the Web with the Search Box .................................................................................... 18
  Searching Within a Web Page .................................................................................................... 20

**Web Browsing Basics Review** ............................................................................................... 21

**More Browser Features** ......................................................................................................... 24
  Changing the Home Page .......................................................................................................... 25
  Using Favorites ......................................................................................................................... 26
  Managing Favorites ................................................................................................................... 28
  Using RSS Feeds ....................................................................................................................... 30
  Using Browsing History .......................................................................................................... 32
  Using Add-ons .......................................................................................................................... 34
  Using Compatibility View ........................................................................................................ 36
  Changing Your View ............................................................................................................... 37
  Setup a Web Page for Printing ............................................................................................... 38
  Previewing and Printing Web Pages ....................................................................................... 39
  Downloading Program Files ................................................................................................... 41
  Downloading Data Files and Images ....................................................................................... 43

**More Browser Features Review** ............................................................................................. 45

**Safe Web Browsing** ................................................................................................................ 48
  Using the SmartScreen Filter .................................................................................................... 49
  Using Domain Highlighting ........................................................................................................ 51
  Using the Information Bar and Pop-Up Blocker ..................................................................... 52
  Using InPrivate Browsing ......................................................................................................... 53
  Using InPrivate Filtering ......................................................................................................... 54

**Safe Web Browsing Review** ................................................................................................... 56
Introducing CustomGuide Courseware

Thank you for choosing CustomGuide courseware as the solution to your training needs. A proven leader in the computer training industry, CustomGuide has been the key to successful training for thousands of students and instructors across the globe.

This manual is designed for computer users of all experience levels. Novice users can use it to learn skills such as formatting text, while advanced users can use it to create their own templates.

All this information is quickly accessible. Lessons are broken down into basic step-by-step instructions that answer “how-to” questions in minutes. You can print a complete 300-page training manual or a single page of instructions.

Here’s how a CustomGuide manual is organized:

Chapters
Each manual is divided into several chapters. Aren’t sure if you’re ready for a chapter? Look at the table of contents that appears at the beginning of each chapter. It will tell you the name of each lesson and subtopic included in the chapter.

Lessons
Each chapter contains lessons on related topics. Each lesson explains a new skill or topic and contains an exercise and exercise file to give you hands-on experience. These skills can also be practiced using CustomGuide Online Learning.

Review
A review is included at the end of the manual. Use these quiz questions and answers to assess how much you’ve learned.

What People Are Saying

“I have saved hundreds of hours of design time by just picking and choosing what I want from the courseware.”
— Stephanie Zimmerman
Lancaster County Library

“We have been able to customize our training sessions on all Microsoft Office products, at all levels. The ROI of these guides is great.”
— Dawn Calvin
Las Virgenes Municipal Water District

“All in all, the friendliest, most open and easy to understand tutorial of its type that I’ve ever seen.”
— W. Boudville
Amazon.com

“…curriculum that is of high quality, student friendly, and adaptable to the audience.”
— Sherrill Wayland
St. Charles Community College

“…a nice training option for almost any need. Their complete Microsoft Office package is by far the best deal on the market.”
— Technical Assistance Program
Purdue University

“Any instructor teaching classes on Windows or Microsoft Office will definitely want to give serious consideration to this important collection of titles that will definitely fit well into their classroom learning.”
— Dale Farris
Golden Triangle PC Club

“The materials are exceptional – I am so excited about using them! Thanks to you and your team for doing this wonderful work!”
— Shannon Coleman
Learning Post Ltd.
How It Works

1. Open Microsoft Word
   Our customizable courseware is provided as simple-to-use, editable Microsoft Word documents—if you can use Microsoft Word you can create your own training materials in minutes!

2. Select Your Topics
   Select the content you need from our award-winning courseware library. You can even mix and match topics between titles, such as Microsoft Outlook and Microsoft Word.

3. Customize
   Arrange topics in the order you want—the courseware automatically updates to reflect your changes. Add your organization’s name and logo for a professional “in-house” look.

4. Print and Distribute
   Print as many copies as you need at your site, without paying any per-unit royalties or maintaining physical inventories. You can print single-page handouts, a group of related lessons, or a complete manual. It’s fast, convenient, and very affordable.

5. Teach and Learn
   You’ll love having your own customized training materials, and your users will appreciate the colorful illustrations, down-to-earth writing style, and the convenience of having a reference guide that they can use in or out of the classroom.

3rd Generation Courseware: What’s New?

CustomGuide is pleased to introduce 3rd generation courseware. Completely redesigned from years of customer feedback, 3rd generation courseware features a streamlined design that is easier to customize and use as a reference tool. Take a look at the table below for more information regarding these features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Streamlined design</td>
<td>Featuring a professional-looking, easy-to-read design, 3rd generation courseware appeals to instructors, students and individual users alike.</td>
</tr>
<tr>
<td>Exercise Notes</td>
<td>A new Exercise Notes section appears at the top of each lesson. Rather than practicing the topic step by step through the lesson as in 2nd generation courseware, the topic can be practiced using the exercise file and exercise described here.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>In addition to the Table of Contents found at the beginning of each courseware title, 3rd generation courseware includes a Table of Contents at the beginning of each chapter, making it even easier to locate the lessons you need.</td>
</tr>
<tr>
<td>Smart Quizzes</td>
<td>The Quiz section, located at the back of the book, automatically updates itself when the manual is customized. For example, if you remove a lesson regarding cutting and pasting text, there will be no questions in the Quiz section that relate to cutting and pasting text.</td>
</tr>
<tr>
<td>Easier customization</td>
<td>The design of 3rd generation is simplified, which makes it easier to customize. All you have to do is click and drag or copy and paste, or press the &lt;Delete&gt; key to remove a lesson, and voila; you’re done!</td>
</tr>
<tr>
<td>Use as a reference tool</td>
<td>3rd generation courseware breaks tasks down into basic step-by-step instructions and can be used as a virtual help desk, answering “how-to” questions in minutes.</td>
</tr>
</tbody>
</table>
Courseware Features

Working with Objects

Positioning Pictures
Whenever you insert a graphic into a presentation, it is inserted inline with text by default. This means that the text in the presentation moves in order to accommodate the graphic. This lesson will show you how to adjust text wrapping and how to use the grid to position objects.

Tips
- If you want to use a graphic with other graphics or objects, they must be on a drawing canvas. See the lesson on drawing shapes for more information.
- Adjust text wrapping
To adjust how text reacts to the objects in your documents, change the object’s text wrapping.

1. Double-click the object whose text wrapping you wish to adjust. The Format contextual tab appears on the Ribbon.
2. Click the Text Wrapping button in the Arrange group. A list of text wrapping styles appears. Take a look at the Text Wrapping Styles table for a description of each style.
3. Select a text wrapping style from the list. The text wrapping style is applied to the image.

Other Ways to Adjust Text Wrapping:
Right-click the image, point to Text Wrapping in the contextual menu, and select an option from the submenu.

To display/hide the grid
Just like the graph paper you used to use in geometry class, the grid consists of horizontal and vertical lines that help you draw and position objects.

1. Click the View tab on the Ribbon.
2. Click the Gridlines check box in the Show/Hide group. Horizontal and vertical gridlines appear on the page.

Other Ways to Display the Grid:
Press <Shift> + <F9>, or click the Format contextual tab on the Ribbon, click the Align button in the Arrange group, and select View Gridlines from the list.


Lesson 7: Working with Objects

Exercise
- Exercise File: AmericanHistory7-3.pptx
- Exercise: Select the header row containing the month labels, the Income row, the Total Exp. Row, and the Net Inc. row (use the Ctrl key to select multiple rows). Create a 2-D Clustered Column chart.

<table>
<thead>
<tr>
<th>Exercise 7-3: Text Wrapping Styles</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sty le</strong></td>
</tr>
<tr>
<td>Format Text</td>
</tr>
<tr>
<td>Top and Bottom</td>
</tr>
<tr>
<td>In Front of Text</td>
</tr>
<tr>
<td>Through</td>
</tr>
<tr>
<td>Behind Text</td>
</tr>
<tr>
<td>In Line with Text</td>
</tr>
<tr>
<td>Square</td>
</tr>
<tr>
<td>In Line</td>
</tr>
</tbody>
</table>
| Figure 7-3: A slide with the grid displayed.
The Internet has changed personal computing forever and continues to affect the way countless tasks are done. The Internet has introduced new ways of sharing recipes, buying music, playing games, paying bills, meeting new people, and staying in touch with old friends.

Fortunately, the Internet is incredibly easy to use. Even the most computer-phobic users tend to feel right at home on the Internet.

This chapter gives an overview of how to use Internet Explorer to navigate the World Wide Web. Lessons include simple Web browsing, using tabs, and searching for information on the Web. There’s a lot to explore on the Internet, with more pages being added every day, so let’s get started!
Introduction to the Internet

The Internet is the largest computer network in the world. It consists of millions of computers all over the planet, all connected to each other. It evolved from the ARPANET, which was created in the 1960s by the U.S. government to protect computer systems in case of a nuclear attack.

Although the Internet has been around since the 1960s, it wasn’t until the 1990s that the World Wide Web was born. The World Wide Web (or Web) is what you probably think of when you think of the Internet, although it’s really just a part of the Internet. The Web consists of millions of documents called Web pages, and you can find Web pages on every subject imaginable—from your local newspaper to online catalogs and airline schedules.

Web pages are stored on Web servers. A Web server is a computer, not unlike your own computer, only bigger and faster. Web servers are always connected to the Internet so that people can view Web pages stored on them 24 hours a day.

So what can you do once you’re connected to the Internet? Plenty. Table 1-1: Internet Activities lists just some of the things you can do once you’re online.

<table>
<thead>
<tr>
<th>Table 1-1: Internet Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Send and receive E-mail</strong></td>
</tr>
<tr>
<td><strong>Browse the World Wide Web</strong></td>
</tr>
<tr>
<td><strong>Join online discussions with newsgroups</strong></td>
</tr>
<tr>
<td><strong>Chat with other online users</strong></td>
</tr>
<tr>
<td><strong>Download software</strong></td>
</tr>
<tr>
<td><strong>Listen to music</strong></td>
</tr>
<tr>
<td><strong>Shop at online retail outlets</strong></td>
</tr>
<tr>
<td><strong>Manage your accounts</strong></td>
</tr>
<tr>
<td><strong>Keep a diary</strong></td>
</tr>
<tr>
<td><strong>Watch videos</strong></td>
</tr>
<tr>
<td><strong>Check schedules</strong></td>
</tr>
<tr>
<td><strong>Play games</strong></td>
</tr>
</tbody>
</table>

Exercise

- **Exercise File:** None required.
- **Exercise:** Understand the difference between the Internet and the World Wide Web.
Understanding the Internet Explorer Window

Before you jump into the world of Web browsing, familiarize yourself with the items, controls, and commands in the Internet Explorer window.

**Title bar**: Displays the name of the active Web page and program.

**Address bar**: Displays the Uniform Resource Locator (URL), better known a Web address. Type an address to visit a Web site.

**Minimize, Maximize, and Close buttons**: Use these buttons to minimize, resize, or close and exit Internet Explorer.

**Navigation buttons**: Move back/forward among Web pages you have browsed.

**Search box**: Type a word or phrase and use a search engine to look for related Web sites.

**Favorites Bar**: Gives you one-click access to your favorite Web pages.

**Command Bar**: Quick access to tools to customize Internet Explorer.

**Tabbed browsing**: Open up Web pages in separate tabs for faster, more convenient browsing.

**Status bar**: Tells you if you’re connected to the Internet and displays the progress the Web site is making in loading. Also displays the security level of the Web site.

**Zoom**: Zoom in to increase the size of the Web page being viewed, or zoom out to display more items in the window.
What's New in Internet Explorer 8

There are lots of exciting new features in Internet Explorer 8 that are designed to deliver seamless, safe, and personal experiences on the Web.

Review Table 1-2: New Features in Internet Explorer 8 for a description of some of these new features. Many will be described in greater detail in later lessons.

### Table 1-2: New Features in Internet Explorer 8

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Slices</td>
<td>A Web Slice is a lot like a bookmark, but instead of subscribing to the entire page, you only subscribe to a specific portion of a Web page.</td>
</tr>
<tr>
<td>Compatibility View</td>
<td>Some Web pages were designed for older versions of Internet Explorer. As a result, they may render oddly in your browser view. Compatibility View allows you to view the Web page as if you were using an earlier version of Internet Explorer.</td>
</tr>
<tr>
<td>Accelerators</td>
<td>Accelerators allow you to perform browsing tasks without having to leave your current Web page. For example, if you want to map an address, you can highlight the text, click the Accelerator button, and a map will appear in the same screen.</td>
</tr>
<tr>
<td>Favorites Bar</td>
<td>Now you have one-click access to your favorite Web pages by adding them to the Favorites Bar, which appears across the top of your browser window.</td>
</tr>
<tr>
<td>New Tab Groups</td>
<td>When you open up a new tab from a Web page, both the original tab and the new tab will be color coded so you know which tabs are related. You can even save tab groups as Favorites.</td>
</tr>
<tr>
<td>Improved Find On Page</td>
<td>The improved Find On Page toolbar appears at the top of your browser. The toolbar searches character-by-character as you type and highlights each match so that they're easy to find within the page.</td>
</tr>
<tr>
<td>Improved Zoom</td>
<td>Pages with small font sizes can be hard to read. Internet Explorer now has Adaptive Page Zoom, which allows you to increase the font size of Web pages and read it without having to scroll from left to right.</td>
</tr>
<tr>
<td>Smarter Address Bar</td>
<td>Sometimes it can be difficult to remember Web pages you have visited. The new address bar now searches across your browsing history, Favorites, and RSS feeds. When you type a few characters into the address bar, it recalls sites for you. The address bar also makes surfing the Internet safer. It highlights the Web domain of the site you're visiting so you know if it's the real thing or a malicious look-alike.</td>
</tr>
<tr>
<td>Improved Instant Search Box</td>
<td>New search capabilities make it easier to find the information you’re looking for. As you type, the search box will suggest Web sites for you. The search box will also provide visual search results. For example, if you type in the name “George Washington,” you may see a picture of him next to your results.</td>
</tr>
<tr>
<td>InPrivate Browsing and InPrivate Filtering</td>
<td>InPrivate Browsing allows you to navigate the Web without leaving any evidence behind. Meanwhile, InPrivate Filtering prevents third-parties from collecting information about your browsing history.</td>
</tr>
<tr>
<td>Better Performance</td>
<td>Microsoft’s developers worked hard to increase the speed and functionality of Internet Explorer, making it a strong contender against competitors like Mozilla’s Firefox and Google Chrome.</td>
</tr>
<tr>
<td>Safer Browsing</td>
<td>By default, Internet Explorer 8 has features that protect you from malware and phishing threats.</td>
</tr>
</tbody>
</table>

### Exercise

- **Exercise File:** None required.
- **Exercise:** Understand the new features that are available in Internet Explorer 8.
Starting Internet Explorer

In order to use Internet Explorer, you must start—or launch—it first.

Windows XP

1. Click the Start button.
   The Start menu appears.

2. Click Internet Explorer.
   The browser window appears.
   ○ Other Ways to Open Internet Explorer:
     Click the Internet Explorer icon in the Quick Launch bar.

Windows Vista

1. Click the Start button.
   The Start menu appears.

2. Click Internet Explorer.
   The browser window appears.
   ○ Other Ways to Open Internet Explorer:
     Click the Internet Explorer icon in the Quick Launch bar.

Windows 7

1. Click the Internet Explorer icon on the taskbar.
   The browser window appears.

   ○ Other Ways to Open Internet Explorer:
     Click the Start button and select All Programs → Internet Explorer from the menu.

Exercise

- Exercise File: None required.
- Exercise: Launch Internet Explorer.

Figure 1-2: Starting Internet Explorer in Windows 7.
Displaying a Specific Web Page

Every page on the Internet has its own Web address called a Uniform Resource Locator (URL). Whenever you hear www.something.com, people are referring to a specific Web page’s URL. Once you know the URL, getting to the Web page is a piece of cake!

Enter a URL in the address bar

When you know a Web site’s URL, enter it in the address bar and the browser will open to that page.

1. Click the address bar. Type the URL in the address bar and press <Enter>.

The Web page appears in the browser window.

If the Web page does not appear or you get a warning message, take a look at Table 1-3: Reasons a Page Cannot Be Displayed for possible solutions.

Other Ways to Enter a URL:
Press <Ctrl> + <L> or <Ctrl> + <O>, type the Web address, and press <Enter>.

Tip: URLs begin with a http:// prefix. In Internet Explorer (and other Web browsers), this prefix does not need to be entered.

Use AutoComplete in the address bar

If you can’t quite remember a URL, you can start typing it in the address bar and AutoComplete will automatically recall sites you’ve visited based on your entry. It searches History, Favorites, and RSS Feeds for matches in the Web site address or any part of the URL to what you type.

1. Click the address bar and begin typing.

Internet Explorer begins searching through your History, Favorites, and RSS Feeds for matches based on what you’ve typed.

2. Click the result that you want to view.

Table 1-3: Reasons a Page Cannot Be Displayed

<table>
<thead>
<tr>
<th>Reason</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>You’ve lost your connection to the Internet</td>
<td>Check your Internet connection (or wireless signal) and try again.</td>
</tr>
<tr>
<td>The Web page does not exist</td>
<td>Check the address you typed or use a search engine to find a new address.</td>
</tr>
<tr>
<td>Too many users are viewing the Web page at once.</td>
<td>Wait for a while (sometimes a few minutes or sometimes a few hours) and try again.</td>
</tr>
<tr>
<td>The server where the Web page is stored is down</td>
<td>Wait for a while and try again.</td>
</tr>
</tbody>
</table>

Figure 1-3: AutoComplete results in the address bar.
Browsing the Web

The World Wide Web is remarkably easy to navigate. It’s so easy that most users can browse Web pages without any training, even if they have difficulty with other computer programs.

This lesson explains how to find your way through the millions of Web sites that are on the Internet.

Use hyperlinks

A journey of a million Web sites starts with a single page. You could browse the Internet just through hyperlinks. Clicking a hyperlink will:

- Take you to a page within the same Web site.
- Take you to a page in a different Web site.
- Take you to a part of the same Web page.
- Allow you to download a file.
- Send an e-mail to a specific e-mail address.
- Play a video, animation, or sound.

Whenever the cursor changes from an arrow to a pointing hand, it is on a hyperlink.

1. Point to a hyperlink and click.
   The browser displays the destination of the link.
   **Tip:** Press <Ctrl> and click to open the link in a new tab. Press <Shift> and click to open the link in a new window.

Return to visited pages

Internet Explorer has several navigation controls that make it easy to browse among pages you have visited.

1. Click the **Back** button.
   The page you previously viewed appears.

2. Click the **Forward** button.
   The page you viewed before clicking the Back button appears.

3. Click the **Recent Pages** button to see the last ten pages you have viewed on a particular tab. Select a page to view it.

4. Click the **Show Address bar AutoComplete** list arrow to see a list of URLs recently typed into the address bar.

Exercise

- **Exercise File:** None required.
Refresh a page

Sometimes a page is slow to load. This usually happens when the computer that stores the Web page is handling a lot of data (for example, when many people are trying to view the page at once). Other times, changes are made to a page that don’t take effect right away. In either of these cases, refreshing the page may solve the problem.

- Click the **Refresh** button.

  The data for the Web page is automatically reset, and the page loads again.

**Other Ways to Refresh a Page:**

Press the `<F5>` key.

**Trap:** In some cases, a Web page may load slowly because it is sending information. If you are in the middle of sending information, as in an online purchase, do not refresh the Web page. You may create a duplicate transaction or cancel the transaction.

Stop a page transfer

If the Web page refuses to load, you may have to throw in the towel and try it again later. The Stop button stops data from transferring so you can navigate somewhere else.

- Click the **Stop** button.

  The data stops transferring and you can continue browsing the Internet.

**Other Ways to Stop a Page Transfer:**

Press the `<Esc>` key.
Browsing with Tabs

Tabs allow you to open multiple Web pages in a single browser window. This makes it easy to switch between Web pages and leaves more room on your taskbar.

Open a tab

Internet Explorer starts with one tab open. You can open additional tabs for pages you want to view.

1. Click the New Tab button.
   A new tab opens to the New Tab page.
   ✓ Other Ways to Open a New Tab:
     Press <Ctrl> + <T>. Or, press <Ctrl> as you click a link to open it in a new tab.
     The New Tab page is a convenient stepping off point for browsing. You can use an accelerator, browse with InPrivate, reopen a tab that was previously closed in your browsing session, or reopen your last browsing section.

2. Type a new URL into the address bar and press <Enter>. Or, use one of the browsing links on the New Tab page.
   The new tab displays the Web page.

✓ Tips
   ✓ To view a tab, click it. Or, press <Ctrl> + <Tab> to cycle through open tabs.

Use Quick Tabs

You can take a quick look at all of your tabs at once using Quick Tabs. This is a single page that lets you view thumbnails (small pictures) for the pages displayed in each tab.

1. Click the Quick Tabs button.
   The Quick Tabs view opens. Each Web page that is open as a tab is displayed as a thumbnail preview.
   ✓ Other Ways to Display Quick Tabs:
     Press <Ctrl> + <Q>.

2. Click a thumbnail.
   The tab with the Web page you selected appears.
   ✓ Tip: Click the Title bar or press <Ctrl> + <Q> to return to the Web page you were viewing before opening Quick Tabs view.

Exercise

- **Exercise File:** None required.
Use Tab Groups

Tab groups let you see which Web pages have related content. When one tab is opened from another, the new tab is placed next to the originating tab and color-coded so that you can quickly see which tabs have related content.

If you close a tab that's part of a group, another tab from the same group is displayed, so you remain within the context of the current topic rather than suddenly looking at an unrelated site.

1. Navigate to a Web page of your choice.

2. Right-click a hyperlink and select Open in New Tab from the contextual menu.

   Internet Explorer treats both the original tab and the new tab as related tabs and assigns them the same color.

   ✔ Tip: To close a tab group, right-click any tab in the group you want to close and select Close This Tab Group.

Close a tab

Once you are done using a tab, you can close it without affecting the other tabs in the window.

1. Click the tab.
   The tab must be active in order to close it.

2. Click the Close Tab button.
   The tab closes.

   ✔ Other Ways to Close a Tab:
   Press <Ctrl> + <W>. Or, click the Close Tab button in Quick Tabs view. You can also right-click the tab and select Close Tab from the contextual menu.

   ✔ Tip: To close all tabs except one, right-click the tab that you would like to keep open and select Close Other Tabs from the contextual menu.

   ✔ Tip: To reopen a tab you just closed, right click any tab and select Reopen Closed Tab from the contextual menu.

   ✔ Tips
   ✔ You can disable tabbed browsing altogether. Click Tools and select Internet Options. On the General tab, click the Settings button under the Tabs section and uncheck the Enable Tabbed Browsing check box.

---

Table 1-4: Tabbed Browsing Keyboard Shortcuts

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a New Tab</td>
<td>&lt;Ctrl&gt; + &lt;T&gt;</td>
</tr>
<tr>
<td>Open a Duplicate Tab</td>
<td>&lt;Ctrl&gt; + &lt;K&gt;</td>
</tr>
<tr>
<td>Open a Link in a New Tab</td>
<td>&lt;Ctrl&gt; + Hyperlink</td>
</tr>
<tr>
<td>Display Quick Tabs</td>
<td>&lt;Ctrl&gt; + &lt;Q&gt;</td>
</tr>
<tr>
<td>Close a Tab</td>
<td>&lt;Ctrl&gt; + &lt;W&gt;</td>
</tr>
<tr>
<td>Reopen a Closed Tab</td>
<td>&lt;Ctrl&gt; + &lt;Shift&gt; + &lt;T&gt;</td>
</tr>
<tr>
<td>Cycle through Tabs</td>
<td>&lt;Ctrl&gt; + &lt;Tab&gt;</td>
</tr>
</tbody>
</table>
Searching the Web with a Search Engine

There are millions of Web pages on the Internet, and they’re not kept in any particular order. Fortunately, Web sites called search engines catalog and index the Web pages on the Internet so you can find information on the topics that interest you.

This lesson teaches you how to search the Web to find the pages you are looking for.

1. Enter the URL of the search engine that you want to use in the address bar and press <Enter>.
   The search engine appears in the browser window. For a list of search engines, see Table 1-5: Popular Search Engines.

2. Type the word or phrase you want to search for in the search engine’s search box and press <Enter>.
   A list of search results appears in the browser window.

3. Click the hyperlink pertaining to the search results that you want to view.
   The Web page appears in the browser window.

Tips

✓ Most search engines also provide links to images, videos, and other resources that are relevant to your search terms. Just click the link in the search engine home page or the results page.

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Use a search engine to find information about Abraham Lincoln.

---

**Table 1-5: Popular Search Engines**

<table>
<thead>
<tr>
<th>URL</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><a href="http://www.google.com">www.google.com</a></td>
<td>Google is consistently ranked as having the most relevant search results and has become the largest name in search engines.</td>
</tr>
<tr>
<td><a href="http://www.yahoo.com">www.yahoo.com</a></td>
<td>Yahoo supplies a number of other services from its search page, including broad topics that can be narrowed down and browsed like a telephone directory.</td>
</tr>
<tr>
<td><a href="http://www.bing.com">www.bing.com</a></td>
<td>Bing is Microsoft’s search engine which offers several services along with their search engine.</td>
</tr>
<tr>
<td>search.aol.com</td>
<td>This is the default search engine for America Online subscribers.</td>
</tr>
</tbody>
</table>
Searching the Web with the Search Box

The search box makes it easy to search the Web. It always appears next to the address bar, so you can search from any Web page or tab without having to go to a search engine beforehand.

Use the search box

The search box is a great starting point for your searches. It is easy to access and it is flexible, allowing you to search among different search engines and providers.

1. Click the search box and type the word or phrase for which you want to search.

   Notice that as you type, a list of relevant suggestions appears below the search box. Visual suggestions, which show up as small images next to a suggestion, may also appear. You can click one of these suggestions at any time to begin a search for that word or phrase.

   ✓ Tip: If you are looking for a specific phrase, (for example, “I Have a Dream”) you can group the words of the phrase together by putting them in quotation marks in the text box. Then the search engine will only search for results that match the entire phrase.

2. Press <Enter>.

   The search is executed and search results are displayed in the browser window.

   ✓ Tip: Press <Alt> + <Enter> to search in a new tab.

   🚨 Other Ways to Execute a Search:
   - Click the Search button at the right side of the Search box.

3. Click the hyperlink for the search result you want to view.

   The Web page appears in the browser window.

Exercise

- Exercise File: None required.
- Exercise: Use the search box to find information about William Shakespeare. Add a new search provider to your search box.

Figure 1-10: Search suggestions, including visual suggestions, appear below the search box.
Add a search box provider

The search box uses Bing as its default search provider, but you can change the search provider and even add search providers to the list.

1. Click the search box list arrow and select Find More Providers from the list.

   The Add-ons Gallery: Search Providers Web page appears.

2. Click the Add to Internet Explorer button for the search provider you would like to use.

   The Add Search Provider dialog box appears. There are two check boxes here:
   - Make this my default search provider: Select this check box to make all searches run through this provider, unless otherwise specified.
   - Use search suggestions from this provider: This is selected by default. Keep it checked if you want suggestions from this provider to appear as you type in the search box.

3. Verify search provider and click Add.

   The search provider is added to the search box list.

Tips

- To modify or remove search providers, click the Tools button on the Command Bar and select Manage Add-ons. Select Search Providers from the Add-on Types list, and select the search provider with which you want to work.

Figure 1-11: You can select from multiple search engines in the search box.
Searching Within a Web Page

Internet Explorer makes finding information on a Web page easier with its Find On Page function.

In this lesson, you’ll learn how to use the Find On Page function to find a specific word or phrase on a Web page.

1. Press <Ctrl> + <F>.

   The Find On Page toolbar appears below the tab. A cursor also appears in the Find text box.

   **Other Ways to Search Within a Web Page:**
   Press the <Alt> key, click the Edit menu and select Find on this Page.

2. Type the word or phrase for which you want to search and press<Enter>.

   Internet Explorer searches the entire Web page as you type. Matches are highlighted in yellow. The number of matches appears at the far right of the Find On Page toolbar.

   If Internet Explorer does not find a match, the Find On Page toolbar indicates “No Matches Found.”

   **Tip:** To turn off highlighting, click the Highlight All Matches button.

   **Tip:** To be more specific in your searches, click the Options button on the Find On Page toolbar and select Match Whole Word Only or Match Case.

3. Click Next or Previous to move between your matches.

   When you’re finished finding matches on the page, close the Find On Page toolbar.

4. Click the Close button on the Find On Page toolbar.

---

**Exercise**

- **Exercise File:** None required.
- **Exercise:** Go to [www.microsoft.com](http://www.microsoft.com). Search for the word “Windows” on the Microsoft home page.

---

**Figure 1-12:** The Find On Page toolbar appears below the tab of the Web page you are browsing.
**Quiz Questions**

1. What is ARPANET?
   A. The 1960s network developed by the U.S. to back up its computer systems.
   B. An insurance plan for AARP members.
   C. The system for sharing documents over the Internet.
   D. A computer that makes Web pages available on the Internet 24 hours a day.

2. Computers that store Web pages are known as:
   A. Standardized protocols
   B. University libraries
   C. Mega-puters
   D. Web servers

3. The ___________ displays the name of the active Web page.
   A. Title bar
   B. Favorites bar
   C. Command bar
   D. Tabbed browsing

4. Which of these is NOT a reason that a Web page would not load?
   A. You have misspelled the Web address.
   B. There are too many people viewing the Web page at one time.
   C. You have lost your connection to the Internet.
   D. The Internet is temporarily closed for cleaning.

5. If you do not type http:// before a Web address, Internet Explorer will add it for you. (True or False?)

6. The Refresh button:
   A. Shows a number of Web pages related to the one you are currently viewing.
   B. Will reload a Web page.
   C. Lets your computer take a five minute break between tasks.
   D. Restores a Web page to the way it looked when it was first created.

7. The Back button will bring you to the last Web page you viewed. (True or False?)

8. You must double-click a hyperlink to activate it. (True or False?)

9. Quick Tabs allow you to:
   A. Quickly open a group of tabs that were saved to your Favorites.
   B. View all of your tabs as thumbnails on one page.
   C. Quickly disable tabbed browsing in Internet Explorer
   D. View the current charges you owe to your Internet Service Provider.
10. If you close a tab:
   A. Nothing happens.
   B. The other tabs will remain open.
   C. All of the tabs will close.
   D. You get to watch an informative video on the uses of tabbed browsing.

11. Search engines allow you to search for Web pages that contain a key word or phrase. (True or False?)

12. Which search providers can you add to your search box?
   A. Google
   B. Wikipedia
   C. Amazon
   D. All of the above

13. The Find On Page function:
   A. Uses Bing to search the Internet for Web pages related to a specific word or phrase.
   B. Finds the lowest price of a product online.
   C. Allows you find each instance of a specific word or phrase on a Web page.
   D. Finds the best search engine so you can find the information you are looking for.

---

**Quiz Answers**

1. A. ARPANET is the 1960s network developed by the U.S. to back up its computer systems.

2. D. Computers that store Web pages are known as Web servers.

3. A. Title bar. The Title bar displays the name of the active Web page.

4. D. If a Web page does not load, it may mean that you have lost your connection to the Internet, you have misspelled the Web address, there are too many people viewing the Web page at once, or there is a problem with the computer the Web page is stored on.

5. True. You do not need to enter http:// before an address because Internet Explorer will add it for you.

6. B. The Refresh button will reload a Web page. This is useful if the page is loading slowly or if new information has come in since you opened it.

7. True. The Back button brings you to the last Web page you viewed.

8. False. Click a hyperlink once to activate it.

9. B. Quick Tabs allow you to view all of your tabs as thumbnails on a single page.

10. B. If you close a tab, the other tabs will remain open.

11. True. Search engines catalog and index Web pages on the Internet so when you enter a key word or phrase, a list of relevant Web pages will be displayed in the search results.
12. D. You can add all of those search providers, including many more, by clicking Find More Providers in the Search box.

13. C. The Find On Page function allows you to search for a word or phrase on a Web page and highlights each instance in yellow.
More Browser Features

Changing the Home Page .................................. 25
Using Favorites.............................................. 26
    Add a Favorite to the Favorites Center.... 26
    View Favorites ...................................... 27
Managing Favorites....................................... 28
    Organize favorites................................. 28
    Add a button to the Favorites bar ......... 28
    Use Suggested Sites ............................... 29
Using RSS Feeds.......................................... 30
    Subscribe to an RSS feed ....................... 30
    View subscribed feeds ......................... 31
    Change feed settings ............................ 31
Using Browsing History................................. 32
    View your browsing history .................. 32
    Delete browsing history ....................... 32
Using Add-ons ............................................. 34
    Use accelerators ................................. 34
    Save Web Slices ................................. 34
    Find other Add-ons ............................... 35
Using Compatibility View.............................. 36
Changing Your View...................................... 37
    Use Zoom ......................................... 37
    Change text size ................................. 37
Setup a Web Page for Printing........................ 38
Previewing and Printing Web Pages .............. 39
    Use Print Preview ............................... 39
    Quick print a Web page ....................... 40
    Print a Web page ............................... 40
Downloading Program Files ......................... 41
Downloading Data Files and Images ............... 43
    Download data files ............................ 43
    Download images ............................... 43

Simple Web browsing and searching brings a lot of information to your fingertips. However, you will find after a very short time that there are certain Web sites that you visit more frequently than others. You’ll also find a lot of interesting programs that you may want to download and use on your computer. Finally, you’ll also want to use the Internet for communicating via e-mail with friends and family. Internet Explorer 8 includes many enhancements that will help you get the most out of your experience navigating the World Wide Web.

In this chapter you’ll learn how to bookmark your favorite Web sites, subscribe to site content that is frequently updated, and view your history so you can get back to that Web site whose name you may have forgotten.
Changing the Home Page

If you find that you make a beeline to the same Web page every time you get online, you might want to make it your home page. The home page is the page that appears as soon as you open your browser.

1. Browse to the page you’d like to make your home page. If you want to use additional pages as your home page, open them in additional tabs.

2. Click the Tools button on the Command Bar and select Internet Options.

The General tab of the Internet Options dialog box appears. Notice that there are several options for setting the home page:

- Use current: The current Web page and any additional pages currently open in tabs become the new home page(s).
- Use blank: No Web page is displayed for the home page.

3. Click the Use current button.

The URL for the current Web page is listed in the box. If you are using multiple home pages, each URL is listed on its own line.

4. Click OK.

The page(s) are saved as your home page.

Other Ways to Change Your Home Page:
Browse to the Web page, click the Home button list arrow on the Command Bar, and select Add or Change Home Page. Select an option from the Add or Change Home Page dialog box and click Yes.

Tips
✓ Whenever you click the Home button on the Command Bar, you return to your home page.
✓ Internet Explorer’s default home page is www.msn.com.

Exercise
- Exercise File: None required.
- Exercise: Set www.google.com as your home page.

Figure 2-1: Change home page settings in the Internet Options dialog box.

Figure 2-2: The Add or Change Home Page dialog box.
More Browser Features

Using Favorites

When you find a Web page that you want to return to frequently, you may want an easy way to get back to it. Internet Explorer provides you a place to save those Web pages: the Favorites Center. In this lesson, you’ll learn how to save and view your favorite Web pages.

Add a Favorite to the Favorites Center

Microsoft has already added a selection of Microsoft Web pages to your Favorites. Here’s how to add some of your own choices to the collection:

1. Open the page you want to add as a favorite.
   The Web page is displayed.

2. Click the Favorites button on the Favorites Bar.
   The Favorites Center appears.

3. Click the Add to Favorites button.
   The Add a Favorite dialog box appears.

   Other Ways to Add a Favorite:
   Press <Ctrl> + <D>.

   Tip: You can add a number of Web sites to the Favorites list at once. Display them all on tabs and click the Favorites button on the Favorites Bar. Click the Add to Favorites button list arrow and select Add Current Tabs to Favorites.

4. (Optional) Type a nickname for the Web page in the Name text box.
   The nickname should be something that is easy to recognize later. Many Web pages automatically have a nickname that works well.

   Now you need to specify where you want to save the Web page within your Favorites.

5. Click the Create in list arrow and select the folder where you want to save the Web page.
   Saving Favorites in folders makes it easy to find the favorite when you need it. If you don’t choose a folder, it will be saved in the Favorites folder.

   Tip: If an appropriate folder does not already exist, click New Folder to create a new one.

6. Click Add.
   The Web page is added to the Favorites Center.

Exercise

- Exercise File: None required.
- Exercise: Open the www.customguide.com Web page and add it to your Favorites.
View Favorites

Once a Favorite has been added, you can view it by accessing it from the Favorites Center.

1. Click the Favorites button on the Favorites Bar.
   The Favorites Center appears.
   - Other Ways to Open the Favorites Center:
     Press <Ctrl> + <I>.

2. Click the Favorite you’d like to view.
   The Web page is displayed.
   - Tip: To display all of the pages saved within a folder as separate tabs, click the Open Tab Group button to the right of the folder name in the Favorites Center.

Figure 2-5: Select a Favorite from the Favorites Center to view it in the browser.
Managing Favorites

Favorites is such a handy feature that it can sometimes be overrun with saved Web sites, making it difficult to find what you’re looking for. If this happens, you should organize your Favorites so that you can easily find them. This lesson shows you how to manage your Favorites to get the most out of them.

Organize Favorites

Keeping track of your Favorites may seem like a big task. Thankfully, there’s a window dedicated solely to keeping them organized.

1. Click the Favorites button on the Favorites Bar, click the Add to Favorites list arrow button in the Favorites Center, and select Organize Favorites.

   The Organize Favorites dialog box appears, with a list of folders in alphabetical order.

2. Organize your Favorites.

   You can create a new folder, or move, rename, or delete the current Web pages and folders in your Favorites Center.

   Tip: You can move an entire folder into another folder. For example, you may want to put folders for North American Travel, European Travel, and South American Travel within a folder called Travel.

3. Click Close.

   The Organize Favorites dialog box closes.

Add a button to the Favorites Bar

The Favorites Bar lets you quickly access your most visited pages.

1. Open the page you want to add to your Favorites Bar.

2. Click the Add to Favorites Bar button on the Favorites Bar.

   The Web page appears as a button on the Favorites Bar.

   Other Ways to Add a Button to the Favorites Bar:
   - Click the Favorites button, click the Add to Favorites button list arrow, and select Add to Favorites Bar.
More Browser Features

Tips
✓ To delete a button from the Favorites Bar, right-click the button and select Delete from the contextual menu.

Use Suggested Sites
The Favorites Bar includes another interesting tool: Suggested Sites. Suggested Sites recommends Web sites you might find interesting based on your browsing history.

1. Click the Suggested Sites button in the Favorites Bar.
   A list of five suggested sites appears.
   ✓ Tip: Suggested Sites uses your browsing history to make suggestions. When you first use Suggested Sites, there might not be enough history for the service to offer you suggestions.

2. Select the Web site you want to visit.
   The Web site appears in the active tab.

Tips
✓ If you want to turn Suggested Sites on or off, click the Tools button on the Command Bar and select Suggested Sites. If a check mark appears next to the Suggested Sites option, Suggested Sites is turned on.

Figure 2-8: Suggested Sites recommends Web pages based on your browsing history.
Using RSS Feeds

Many Web sites, such as blogs or news sites, frequently update content for their readers. While you could add the Web site as a favorite in Internet Explorer’s Favorite Center, you may find it easier to subscribe to the site’s RSS feed.

RSS stands for Really Simple Syndication. It provides a simple way for Web publishers to automatically distribute the content on their Web site. That content may include:

- Articles
- Pictures
- Video, or
- Audio, such as podcasts.

When you subscribe to an RSS feed, Internet Explorer downloads new content as it is posted. So, if you subscribe to several feeds, you can check them all and view only the content that you want to view.

In this lesson, you’ll learn how to subscribe to RSS feeds and how to check the feeds for new content.

Subscribe to an RSS feed

1. Open the Web site that offers the feed to which you want to subscribe.

If the Web site offers feeds, the orange RSS feeds button appears on the Command Bar.

2. Click the Feeds button in the Command Bar.

A list of the site’s available feeds appears.

Other Ways to View Available Feeds: Press <Alt> + <J>.

3. Click the Subscribe to this feed link for each of the feeds to which you want to subscribe.

The Subscribe to this Feed dialog box appears. Here, you have the option of changing the name of the feed and assigning the feed to a folder.

4. Click Subscribe.

Internet Explorer confirms that you’ve successfully subscribed to the feed.

Tip: You can add the feed to your Favorites Bar by clicking the Add to Favorites Bar check box.
View subscribed feeds

Once you subscribe to a feed, you can view it in much the same way you would a Favorite.

1. Click the Favorites button on the Favorites Bar and click the Feeds tab in the Favorites Center.
   A list of feeds you are subscribed to appears.
   ✓ Tip: Feeds with new content appear in bold text in the Feeds tab.

2. Click a feed to view new content.
   A list of headlines and/or full articles appears.

3. Click a headline to view the to the Web site’s RSS feed page.

Change feed settings

1. Click the Tools button on the Command Bar and select Internet Options.
   The Internet Options dialog box appears.

2. Click the Content tab, then click the Settings button in the Feeds and Web Slices section of the dialog box.
   The Feed and Web Slice Settings dialog box appears. Here, you can change how often Internet Explorer checks the feeds for new content and choose advanced settings.
   Advanced feed settings include:
   - Automatically mark feed as read when reading a feed.
   - Play a sound when a feed is found for a Web site.
   - Play a sound when a monitored feed is updated.

3. Select the settings you wish to use and click OK
   Internet Explorer applies your changes and closes the dialog box.

Table 2-1: Popular RSS Feeds

<table>
<thead>
<tr>
<th>Feeds</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBC World News</td>
<td>The latest international news from the BBC.</td>
</tr>
<tr>
<td>CNN.com</td>
<td>Top stories from around the world from the cable news network.</td>
</tr>
<tr>
<td>Wired Top Stories</td>
<td>The latest science and technology news.</td>
</tr>
<tr>
<td>Dictionary.com Word of the Day</td>
<td>Learn a new word every day!</td>
</tr>
</tbody>
</table>
Using Browsing History

Let’s say you found a great Web site yesterday on custom-built ice sculptures. It would make a wonderful anniversary gift, but you can’t remember the Web address. Internet Explorer saves the history of your Web browsing for just such an occasion.

View your browsing history

You can find a history of every Web page you’ve visited for the last several weeks in the Favorites Center.

1. Click the Favorites button on the toolbar.
   The Favorites Center appears.

2. Click the History tab.
   Your browsing history appears, grouped by date.

   Other Ways to Open Your Browsing History:
   Press <Ctrl> + <H>.

3. Click the View By list arrow.
   A list of ways to view your history appears. See Table 2-2: Viewing Browser History for the list of options you have for browsing your history.

4. Click a folder.
   The pages saved in the fold are listed.

5. Click a specific Web page.
   The page appears in the browser window.

Delete browsing history

Of course, if you know how the browsing history works, your spouse might know too. To keep the ice sculpture gift a secret, you’ll have to remove the Web page from your browsing history or delete the history entirely.

1. Click the Safety button on the Command Bar and select Delete Browsing History.
   The Delete Browsing History dialog box appears. You can delete the following:
   - Temporary Internet Files: Copies of Web sites you have viewed that are saved so they load faster when you return.
   - Cookies: Files stored that save data such as login information.
   - History: A list of Web pages you have visited.

Exercise

- Exercise File: None required.
- Exercise: View your browsing history, and then delete it.

Table 2-2: Viewing Browser History

<table>
<thead>
<tr>
<th>View by Date</th>
<th>Sorts your history by date, showing the oldest first.</th>
</tr>
</thead>
<tbody>
<tr>
<td>View by Site</td>
<td>Alphabetically sorts folders for the sites you visited in ascending order.</td>
</tr>
<tr>
<td>View by Most Visited</td>
<td>Shows a list of your most frequently visited Web sites in order of most visited.</td>
</tr>
<tr>
<td>View by Order Visited Today</td>
<td>Shows a list of all of the Web sites you visited today, showing the most recently visited sites first.</td>
</tr>
<tr>
<td>Search History</td>
<td>Searches your history.</td>
</tr>
</tbody>
</table>
More Browser Features

- **Form Data:** Information that has been typed into forms.
- **Passwords:** Some sites automatically fill in passwords on your return visit.
- **InPrivate Filtering Data:** Collects information and uses it to determine if Web sites are sharing information about your visit with a third party.

2. Select the check boxes for the items you want to delete.

3. Click **Delete**.

The browsing history is deleted.

قود **Other Ways to Delete Your Browsing History:**

You can also delete one item at a time from your history. Open the History tab, right-click the item and select **Delete** from the contextual menu.

Figure 2-14: The Delete Browsing History dialog box.
Using Add-ons

Add-ons let you personalize your browser by adding Web sites, toolbars, and other features to Internet Explorer. Two add-ons that are included with IE 8 are accelerators and Web Slices.

Use accelerators

While looking at a museum’s Web site you want to see how close it is to your house. Instead of navigating to another Web site to find that information, you can use an accelerator. New in IE 8, an accelerator allows you to highlight a word or phrase on one page and jump to another page with that word or phrase.

1. Navigate to a Web page in the browser window.
2. Highlight the word or phrase that you want to use.
   The Accelerator icon appears.
3. Click the Accelerator icon.
   A contextual menu appears. Default options include blogging, e-mailing, mapping, and searching for the word or phrase.
4. Select the action you would like to take.
   A new Web page opens in a new tab.

Tips

✓ To get additional accelerators and disable and remove default accelerators, click the Tools button on the Command Bar and select Manage Add-ons. Select Accelerators to manage your accelerators.

Save Web Slices

There are some Web pages you may check many times a day for updates. You can add these pages as Web Slices. Internet Explorer alerts you when a Web Slice is updated.

1. Navigate to a Web page in the browser window.
   Not all Web sites have Web Slices available. If the green Web Slice icon appears in the Command Bar, then the Web site is Web Slice enabled.
2. Click the Web Slice icon in the Command Bar.
   The Internet Explorer dialog box appears.

Exercise

- Exercise File: None required.
- Exercise: Go to www.customguide.com and use the Map with Live Search accelerator to find CustomGuide’s location. Explore the Add-ons Gallery.

Figure 2-15: Use an accelerator to get more information on a word or phrase.

Figure 2-16: Click the Web Slice icon to add this page as a Web Slice.
3. Click the Add to Favorites Bar button in the Internet Explorer dialog box.

A new button appears in your Favorites Bar. When the Web Slice is updated, the button will appear in bold on the Favorites Bar.

See Table 2-3: Helpful Web Slices for some commonly-used Web Slices.

**Tips**

- If you want to delete a Web Slice from your Favorites Bar, right-click the Web Slice and select Delete from the contextual menu.

**Find other Add-ons**

There are other add-ons that can change the appearance of your browser or provide you with additional tools. Follow these steps to find more add-ons:

1. Click the Get More Add-ons button on the Favorites Bar.

A list of add-ons appears.

2. Click the Find more in the Internet Explorer Add-ons Gallery link.

The Add-ons Gallery appears. You can search the gallery, browse through categories for helpful add-ons, or search for specific Internet Explorer 8 Add-ons.

**Other Ways to Find Other Add-ons:**

Type [www.leaddons.com](http://www.leaddons.com) in the address bar and press <Enter>.

<table>
<thead>
<tr>
<th>Table 2-3: Helpful Web Slices</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weather from Bing</td>
</tr>
<tr>
<td>MSN Headlines</td>
</tr>
<tr>
<td>Finance from Bing</td>
</tr>
<tr>
<td>Traffic from Bing</td>
</tr>
</tbody>
</table>

**Figure 2-17:** The Get More Add-ons button suggests various add-ons and provides a link to the Add-ons Gallery.
Using Compatibility View

Not all Web sites were designed with the newest version of Internet Explorer, IE 8, in mind. As a result, you might run into a few compatibility problems. Some Web sites that were designed for older browsers may not display properly: the menus might not be in the right place, the images might be blurry, or the text may not be sized correctly. To view these Web sites, IE 8 provides Compatibility View.

- Click the Tools button on the Command Bar and select Compatibility View.

The page appears correctly in the browser.

Other Ways to Turn on Compatibility View:
- Click the Compatibility View button in the address bar.

Tips
- Microsoft provides automatic updates for Web sites with known issues. These updates are downloaded if you have automatic updates enabled.
- You can see a list of all the Web sites you have viewed in Compatibility View. Click the Tools button on the Command Bar and select Compatibility View Settings. Once you’ve turned on Compatibility View for a Web site, Internet Explorer will remember that you’ve turned it on.

Exercise
- Exercise File: None required.

Figure 2-18: If a Web site does not display correctly, use Compatibility View.

Figure 2-19: The Compatibility View Settings dialog box displays sites you’ve viewed in Compatibility View.
Changing Your View

Web pages with small text and images can be very difficult to read. Internet Explorer has two features that allow you to manually adjust the appearance of Web pages so that they are easier on your eyes: Zoom and Text Size.

In this lesson, you’ll learn how to use Zoom to zoom in or out on a Web page. You will also learn how to change the size of the text.

Use Zoom

All Web pages appear at 100 percent of their size by default. When you zoom in, you increase the size of all content on the Web page. By contrast, when you zoom out, you decrease the size of all content on the Web page.

1. Click the Page button on the Command Bar, point to Zoom, and select a zoom level from the menu.

The Web page zooms in or out depending on your selection.

Other Ways to Zoom:
Press <Ctrl> + + to Zoom In or press <Ctrl> + - to Zoom Out. Or, you can click the Change zoom level list arrow in the lower right corner of the browser window and make a selection from the contextual menu.

Tip: You can customize the Zoom magnitude by clicking the Custom option and entering your own zoom percentage.

Change text size

Contrary to zooming, when you change the size of text in your browser window, you are not changing the size of any other elements, such as images, on the Web page.

1. Click the Page button on the Command Bar, point to Text Size, and select a text size from the menu.

The text size increases or decreases in size depending on your selection.

Tip: The text size may not change on some Web Sites. Try zooming in or out instead.

Tips

✓ Whenever you use one of these features, they will apply to all Web sites that you visit. To return to your default view, change the Zoom percentage to 100% and the text size to Medium.

Exercise

Exercise File: None required.

Exercise: Go to www.lifehacker.com. Zoom to 200% and then back to 100%. Change the text size to Largest. Return the text size to Medium.
Setup a Web Page for Printing

Web sites are not designed to be printed; they are designed to look good on your display. There will come a time, however, when you'll want to print out a Web page, whether it is a receipt for an item that you purchased or an article that you are using for research. In this lesson, you'll learn how to adjust the setup of a Web page and include additional information in the headers and footers.

1. Go to the Web page that you would like to print.

2. Click the Print button list arrow on the Command Bar and select Page Setup.

   The Page Setup dialog box appears. Here, you can specify setup options. See Table 2-4: Sections in the Page Setup Dialog Box for a list of changes you can make to the printed appearance of Web pages.

3. Specify setup options, then click OK.

   The Page Setup dialog box closes and the Web page is ready to print.

   Tip: Many Web sites provide an option for printing a page, like a receipt, that is more printer-friendly than the regular Web page. You don’t have to change page setup settings with this option.

Table 2-4: Sections in the Page Setup Dialog Box

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
</table>
| Paper Options         | **Page Size:** Change the size of the paper on which you are going to print the Web page.  
                        | **Portrait:** Orient the page vertically.  
                        | **Landscape:** Orient the page horizontally.  
                        | **Print Background Colors and Images:** Off by default, this option allows you to print the colors or images underlying the text on the Web page. Keeping this option unchecked allows you to save ink or toner in your printer.  
                        | **Enable Shrink to Fit:** Automatically shrinks the Web page so that it fits the selected paper size. |
| Margins (inches)      | Adjust the size of the margins (in inches) on the left, right, top, and bottom of the page. |
| Headers and Footers   | **Header:** Change the information that appears in the header of the printed Web page.  
                        | **Footer:** Change the information that appears in the footer of the printed Web page.  
                        | **Change Font:** Change the text’s font on the printout. |

Exercise

- **Exercise File:** None required.
- **Exercise:** Go to www.msn.com and click on any news article. Add Time to the middle of the Footer. Change the margins to one inch on all sides.
Previewing and Printing Web Pages

Before you print out a Web page, it’s a good idea to see how it will look before you hit the Print button.

Use Print Preview

1. Navigate to the Web page that you would like to print.

2. Click the Print button list arrow on the Command Bar and select Print Preview.

   The Print Preview window appears and the Web page is shown in Preview mode.

   ✔ Tip: Use the commands on the Print Preview toolbar to adjust the page setup settings.

3. Click the Print Preview window’s Close button to return to the Web site.

   ✔ Tip: You can print directly from the Print Preview window by clicking the Print button on the Command Bar.

Table 2-5: Print Preview Commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Print</td>
<td>Prints the Web page.</td>
</tr>
<tr>
<td>Portrait</td>
<td>Orient the page vertically.</td>
</tr>
<tr>
<td>Landscape</td>
<td>Orient the page horizontally.</td>
</tr>
<tr>
<td>Page Setup</td>
<td>Opens the Page Setup dialog box.</td>
</tr>
<tr>
<td>Turn headers and footers on and off</td>
<td>Display additional information about the Web page at the top and bottom of the page.</td>
</tr>
<tr>
<td>View Full Width</td>
<td>Zoom the Web page to the full width of the print preview screen.</td>
</tr>
<tr>
<td>View Full Page</td>
<td>Zoom out to show the full page in the print preview screen.</td>
</tr>
<tr>
<td>Show Multiple Pages</td>
<td>View multiple pages on the preview screen.</td>
</tr>
<tr>
<td>Change Print Size</td>
<td>Stretch or shrink the Web page to fit the printed page.</td>
</tr>
<tr>
<td>First Page / Last Page</td>
<td>Go to the first page/last page.</td>
</tr>
<tr>
<td>Previous Page / Next Page</td>
<td>Go to the previous page/next page.</td>
</tr>
<tr>
<td>Adjust margin</td>
<td>Change the page margins by dragging the horizontal and vertical markers.</td>
</tr>
</tbody>
</table>

Exercise

- Exercise File: None required.
- Exercise: Go to www.msn.com. Click on a news article. Print Preview the article and then print the article.
Quick print a Web page

Quick printing a Web page bypasses the Print dialog box and sends the document directly to the printer.

1. Click the Print button on the Command Bar.

Print a Web page

1. Click the Print button list arrow on the Command Bar and select Print.

The Print dialog box appears. Here you can specify print options. See Table 2-6: Settings in the Print Dialog Box for options that you can change.

Other Ways to Print:
Press <Ctrl> + <P>.

2. Specify printing options, then click Print.

The Web page is sent to your printer.

Table 2-6: Settings in the Print Dialog Box

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Printer</td>
<td>Used to select what printer to send your document to when it prints. If you are connected to more than one printer, the currently selected printer is displayed.</td>
</tr>
<tr>
<td>Preferences button</td>
<td>Displays a dialog box with options available to your specific printer. The Properties dialog box will change according to the type of printer you use, but here are some common print properties:</td>
</tr>
<tr>
<td>Paper Size</td>
<td>Change the size of the paper you're printing to.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Change the paper orientation (portrait or landscape) or print on both sides of the sheet.</td>
</tr>
<tr>
<td>Color/Mono</td>
<td>Print in black and white or choose how you want to print colors in your document.</td>
</tr>
<tr>
<td>Page range</td>
<td>Allows you to specify what pages you want to print. There are several options here:</td>
</tr>
<tr>
<td>All</td>
<td>Prints the entire document.</td>
</tr>
<tr>
<td>Current page</td>
<td>Prints only the page you’re currently on.</td>
</tr>
<tr>
<td>Selection</td>
<td>Prints only selected document content.</td>
</tr>
<tr>
<td>Pages</td>
<td>Prints only the pages you specify. Select a range of pages with a hyphen (5-8) and separate single pages with a comma (3,7).</td>
</tr>
<tr>
<td>Number of copies</td>
<td>Specifies the number of copies you want to print.</td>
</tr>
</tbody>
</table>
Downloading Program Files

There are countless Web sites that offer program files that you can download for installation on your computer. Each site makes programs available in a different way. In fact, most Web sites provide instructions for the best way to download a program, but for most files there are only a few basic steps to follow.

You can identify program files by looking for the .exe and .msi file extensions. Larger program files may be compressed in a zip folder that ends with the .zip file extension.

Trap: There are some dangers to downloading content, so make sure your computer has an anti-virus program installed before you download anything. The most common file types to carry a virus end with the following file extensions: .exe, .scr, .bat, .com, or .pif.

1. Click the download link for the program.

The File Download dialog box appears asking if you would like to Run or Save the file. The difference between the Run and Save commands is small but significant:

- **Run**: Internet Explorer automatically downloads the program and begins the program installation process.
- **Save**: The Save As dialog box appears. Select the location on your local hard drive where you would like to save the file. To begin the program installation, open the location where you saved the file and double-click the downloaded file.

Tip: The Information Bar may appear and block the download before the File Download dialog box appears. If this happens, click the Information Bar and select Download File from the menu.

Tip: Saving is a better option for large files that take a long time to download.

2. Click the Run or Save button.

The file downloads to your computer.

Once the download is completed, follow the instructions provided or begin the installation process.

Other Ways to Download a Program:

Right-click the link to the program you want to download. From the contextual menu, select **Save Target As**. Select the folder in which you would
like to save the file. Rename the file, if desired, and click **Save**.

**Tips**

- Downloading large files from the Internet can take a long time—especially if you use a dial-up connection.
- Not all downloads are free, especially software upgrades and programs. Be sure to check if there is a cost associated with downloading a program.
- Downloading and installing new program files may require administrator privileges. If you find that you cannot download and/or install a program, contact your system administrator.
Downloading Data Files and Images

As you browse the Web, you will encounter data files to download, or transfer, to your computer for use by your programs. These data files include images, music, documents, and more. Each site makes files available in a different way, but for most data files there are a few basic steps to follow to download a file.

In this lesson you will learn how to transfer files and images to your computer.

Trap: There are some dangers to downloading content, so make sure your computer has an anti-virus program installed before you download anything. The most common file types to carry a virus end with the following file extensions: .exe, .scr, .bat, .com, or .pif.

Download data files

Downloading files is very simple process: just click the link to begin the download.

1. Click the download link for the file.

   The File Download dialog box appears. You have the option of opening the file or saving the file.

   ● Open: Opens the file in the default program assigned to handle the file’s type. For example, if the file is a Word document, the Microsoft Office Word program will open and display the document.

   ● Save: Downloads the file and saves the file to the location that you specify. To open or use the file, open the location where you saved the file and double-click on the downloaded file.

2. Click the Open or Save button.

   The data file downloads to your computer.

Other Ways to Download a Program:

   Right-click the link to the data file you want to download. From the contextual menu, select Save Target As. Select the folder in which you would like to save the file. Rename the file, if desired, and click Save.

Download images

Downloading images is a little trickier than downloading other data files, but just as simple.
1. Right-click the picture or image and select **Save Picture As** from the contextual menu.

   The Save Picture dialog box appears.

2. Select the location to which you want to save the image and click **Save**.

   The image downloads and is saved to your computer.

   **Trap:** Be careful when using downloaded images elsewhere. The image may be copyrighted. If you are unsure, it is best to ask the Webmaster from whom you downloaded the image for permission to use it.

   **Other Ways to Download a Program:**
   Right-click the link to the image you want to download. From the contextual menu, select **Save Target As**. Select the folder in which you would like to save the file. Rename the file, if desired, and click **Save**.

   **Tips**
   - downloading large files from the Internet can take a long time—especially if you use a dial-up connection.
   - Not all downloads are free, especially software upgrades and programs. Be sure to check if there is a cost associated with downloading a file.
   - Data files require special programs in order to be used. Make sure you have the required programs before you download.
   - Some document files open directly in your browser window instead of downloading to your computer. This is common with text (.txt) files and portable document format (.pdf) files.
More Browser Features Review

Quiz Questions

14. The home page will appear when:
   A. You restart your computer.
   B. You click the Home button on the Command bar.
   C. Your Internet connection is lost.
   D. You type www.homepage.com in the address bar.

15. You can save more than one page as a home page. (True or False?)

16. When you add a Favorite, you must add it to one of the existing folders. (True or False?)

17. You can display the Favorites Center by pressing <Ctrl> + <F>. (True or False?)

18. Once you add a Favorite to the Favorites Center, you can never delete that Favorite. (True or False?)

19. Suggested Sites recommends Web sites based on:
   A. Your browsing history
   B. Google ranking
   C. Web sites in your Favorites Center
   D. Programs you’ve downloaded from the Internet

20. What does RSS stand for?
    A. Really Small Slices
    B. Really Simple Syndication
    C. Really Sleazy Syndication
    D. Really Simple Subscription

21. How do you access RSS feeds to which you’ve subscribed?
    A. By going to the Favorites Center and clicking on the Feeds tab.
    B. By searching for My RSS feeds in the search box.
    C. By clicking the Page button on the Command bar and selecting Feeds from the menu.
    D. By going to the Internet Explorer Home Page.

22. How far back does Internet Explorer keep track of your browsing history?
    A. A few months.
    B. A few hours.
    C. A few weeks.
    D. Several years.

23. How do you access your browsing history?
    A. Click the History button.
    B. Click the Favorites Center button on the Command bar and select the History tab.
C. Select Tools > Histories > Browsing History from the Command bar.
D. Visit www.history.com

24. What is the purpose of an accelerator?
   A. It makes your Internet connection faster.
   B. It helps you search for a word or a phrase using maps, search engines, and translators.
   C. It speeds up your e-mail delivery.
   D. It tells you what search terms to use.

25. Compatibility View displays Web pages designed for Windows Vista in Windows 7. (True or False?)

26. Which feature of Internet Explorer allows you to increase or decrease the size of ALL content in your browser window?
   A. Changing text size
   B. Compatibility View
   C. The SmartScreen Filter
   D. Zoom

27. When you setup a page for printing, it is a good idea to print the background colors and images. (True or False?)

28. Which of the following is NOT a way you can adjust the a Web page in the Print Preview window?
   A. Turn headers and footers on and off
   B. Adjust margins
   C. Choose between printing in black and white or color
   D. Change print size

29. Which command button in the File Download dialog box should you click if you want to download and automatically install a program file?
   A. Save
   B. Cancel
   C. Open
   D. Run

30. Before you download any files or software, make sure you have an anti-virus program installed on your computer. (True or False?)

**Quiz Answers**

14. B. The home page will appear when you click the Home Page button on the Command bar. It also appears whenever you open a new browser window.

15. True. You can save more than one page as a home page. Each page will appear in a separate tab.

16. False. You can create new folders and sub folders to store Favorites. However, you aren't required to use folders when adding a Favorite.
17. False. You can display the Favorites Center by pressing <Ctrl> + <I>.
18. False. You can move, rename, or delete your folders and Favorites in Organize Favorites.
19. A. Your browsing history
20. B. Really Simple Syndication provides a simple way for web publishers to syndicate the content on their Web site.
21. A. You can access the feeds to which you’ve subscribed by going to the Favorites Center.
22. C. Internet Explorer will keep track of the last 3 weeks of your browsing history.
23. B. You can access your browsing history by clicking the Favorites Center button and selecting the History tab.
24. B. It helps you search for a word or a phrase using maps, search engines, and translators.
26. D. Zoom allows you to zoom in to a page to magnify everything or zoom out to minimize the appearance of everything. Changing the text size will only increase or decrease the size of the text, not other elements like pictures.
27. False. The background colors and images generally do not contain any content you would need to print and is a waste of ink or toner.
28. C. You cannot choose between color and black and white printing from the Print Preview window. You can, however, change that setting in the Print dialog box.
29. D. When you click Run Internet Explorer will automatically download the program file and begin the installation process.
30. True. You should install a virus protection program, also called an anti-virus program, on your computer if you intend to download files.
The Internet, for all of its wonders, can be a treacherous place. For as many people out there who are trying to provide you with helpful information and a positive online shopping experience, there are also those people who would trick you into downloading harmful software onto your computer and steal your personal information. The Internet is a jungle, and you need to be armed with tools that can help protect you.

Fortunately, Internet Explorer 8 was designed to help keep you safe. It comes packed with several tools that steer you away from dangerous Web sites, block annoying pop-ups, and keep your Web browsing safe from the prying eyes of others.

This chapter shows you how to increase your awareness when browsing the Web and how to use Internet Explorer’s tools to keep you safe.
Using the SmartScreen Filter

One of the most common ways to steal personal information on the Web comes in the form of phishing Web sites. Phishing schemes trick users into giving up personal information like credit card numbers, Social Security Numbers, user IDs and passwords.

While there are methods for visually determining which Web sites are safe and which are not, even the experts can be fooled sometimes. Fortunately, Internet Explorer helps protect you with the SmartScreen Filter.

The SmartScreen Filter works in the background as you browse. It detects phishing Web sites and protects you from downloading malicious software, or malware, like viruses. The SmartScreen Filter functions in three ways:

- It blocks Web sites that have any characteristics in common with phishing sites.
- It blocks Web sites that Microsoft has flagged as unsafe.
- It blocks the download of known malware.

Check a Web site manually

Over the course of browsing the World Wide Web, you may come across a Web site that you find suspicious, but was not blocked by the SmartScreen Filter. In this case, you may want to manually check the Web site against Microsoft’s list of malicious Web sites.

1. Go to the Web site that you want to check.
2. Click Safety on the Command Bar, and select SmartScreen Filter → Check This Web site from the menu.

   Internet Explorer checks the Web site against a list of reported Web sites. If the site was reported as a threat, you will receive a warning. If the site has not been reported, follow the instructions in the dialog box that appears.

Report an unsafe Web site

Microsoft’s list of unsafe Web sites is by no means complete. If you come across a Web site that you believe to be unsafe, you may report it yourself.

1. Go to the Web site that you want to report.
2. Click Safety on the Command Bar and select SmartScreen Filter → Report Unsafe Website from the menu.

   The Web site is reported to Microsoft as unsafe.
Disable the SmartScreen Filter

The SmartScreen Filter is automatically turned on by default in Internet Explorer. However, you can disable the SmartScreen Filter. You may want to do this if you frequently visit a site that is reported as unsafe, though you know it to be perfectly safe.

1. Click Safety on the Command Bar and select SmartScreen Filter → Turn Off SmartScreen Filter from the menu.

   A dialog box appears to confirm the changes you are about to make to the SmartScreen Filter.

2. Select the Turn off SmartScreen Filter option and click OK.

   The SmartScreen Filter is disabled.

Figure 3-3: Disabling the SmartScreen Filter.
Using Domain Highlighting

Web site forgery is one of the most common ways to trick people on the World Wide Web. Web site forgers create a copy of a legitimate Web site, fooling people into giving up personal information. For example, you may receive an e-mail from what appears to be your bank asking you to verify your User ID and password. When you click the link to get to the Web site, it looks exactly like the real thing. However, when you attempt to login, you are actually sending the information to an identity thief.

Domain highlighting helps to protect you from Web site forgery by making it easier to distinguish between real and misleading Web addresses. For example, let’s say you want to visit the Microsoft home page.

The actual URL looks like this:


A fake version of the URL, however, might look like this:


It looks like you’re on the Microsoft.com Web domain, but in fact you are on the Fake.com Web domain. Notice that the domain name in the address bar is displayed in black, while the rest of the Web address is in gray.

1. Navigate to a Web page in the browser window and look at the address bar.
   Notice that only the domain name is in black, while the rest is in gray.

Tips

✓ Check the highlighted domain whenever you’re doing online banking, online shopping, or inputting other sensitive information, like usernames and passwords. That way, you can be more confident that you are on the correct Web site.

✓ Create Favorites for places like online banks so you can be confident that you’re always going to the correct Web address, rather than a fake Web address that exploits common misspellings.

✓ Don’t follow hyperlinks in e-mails to Web sites where you may have to input your username and password, even if it appears to come from your bank. Type the URL yourself or use your Favorites. By doing so you can be more certain that you’re not falling for a scam or well-crafted forgery.

Exercise

• Exercise File: None required.
• Exercise: Go to Microsoft’s Web site. Notice how domain highlighting appears in the address bar.
Using the Information Bar and Pop-Up Blocker

Not all Web pages are safe. Some contain malicious code that could be downloaded onto your computer, and some pummel you with a bevy of annoying pop-up ads. Internet Explorer uses the Information Bar to give you a warning before either of these attacks can take place.

Use the Information Bar

The Information Bar notifies you when a security action has taken place in order to protect you from harmful files. It may appear if you try to download a program, if a Web site tries to install an ActiveX control, if active content tries to run on your computer automatically, or if a pop-up is blocked. Here’s what to do when the Information Bar appears:

1. Click the Information Bar.
   A menu appears, giving you options if you want to allow the action.

2. Select a command from the contextual menu.
   The command occurs: for example, the file is downloaded to your computer.

Change Pop-up Blocker settings

The Pop-up Blocker prevents annoying advertisement windows from disrupting your Web browsing. You can adjust the settings from heavy filtering to light filtering or even turn it off altogether. Here’s how:

1. Click the Tools button on the Command Bar and select Pop-up Blocker → Pop-up Blocker Settings from the menu.
   The Pop-up Blocker Settings dialog box appears.
   Here, you can control exceptions, notifications and filter level for the Pop-up Blocker.

2. Configure the Pop-up Blocker settings.
   See Table 3-1: Pop-up Blocker Settings for more information on these settings.

3. Click Close.
   Tip: You can turn off the Pop-up Blocker completely, although you’ll probably find you prefer at least a little bit of filtering.

Table 3-1: Pop-up Blocker Settings

<table>
<thead>
<tr>
<th>Exceptions</th>
<th>Add sites that you always want to view pop-ups from by adding them to the Allowed Sites list.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Notifications and blocking level</td>
<td>Play a sound or have the Information Bar appear when a pop-up is blocked.</td>
</tr>
<tr>
<td>Blocking level</td>
<td>Choose High, Medium, or Low filtering for pop-up ads.</td>
</tr>
</tbody>
</table>
Using InPrivate Browsing

Whenever you browse the Internet, you leave traces of your activity behind on your computer. Anyone with even a small amount of computer savvy can figure out where you’ve been online and what you’ve been doing. See Table 3-2: Evidence of Your Browsing and Searching for some of the signs that other users on your computer can find.

A new Internet Explorer 8 feature allows you to browse and search the Internet with complete privacy, preventing Internet Explorer from storing any information about your browsing session. In this lesson, you’ll learn how to use InPrivate Browsing.

1. Click the New Tab button.
   The New Tab screen appears.

2. Click the Open an InPrivate Browsing window link.
   Internet Explorer opens a new browser window indicating that InPrivate is turned on. The address bar also changes to show that you are now browsing in InPrivate mode.

   Other Ways to Open InPrivate Browsing:
   Click the Safety button in the Command Bar and select InPrivate Browsing from the menu. Or, press <Ctrl> + <Shift> + <P>.

   Tip: Third-party toolbars (such as those you can install from Google and Yahoo!) are disabled by default when you are InPrivate Browsing mode. If you have installed any extensions, they are disabled as well.

   Internet Explorer will not save your browsing history during your InPrivate session.

   Trap: InPrivate browsing may prevent other users of your computer from seeing your browsing activity, but your employer can still monitor your online behavior if you’re at work!

   Tips
   ✓ To stop InPrivate Browsing, close the browser window.

Table 3-2: Evidence of Your Browsing and Searching

<table>
<thead>
<tr>
<th>Evidence Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>History</td>
<td>A list of all the sites that you visited.</td>
</tr>
<tr>
<td>Temporary Internet files</td>
<td>A cache of files downloaded and saved to your computer when you visit Web pages.</td>
</tr>
<tr>
<td>Form data</td>
<td>Information you input into online forms and may include names, addresses, phone numbers and other personal data.</td>
</tr>
<tr>
<td>Cookies</td>
<td>Small pieces of text stored by your Web browser that is used to store shopping cart contents, track activity, or store user preferences.</td>
</tr>
<tr>
<td>Usernames and passwords</td>
<td>Information you use to login to Web sites.</td>
</tr>
</tbody>
</table>

![InPrivate Browser window with the address bar indicator](image)

Figure 3-6: The InPrivate Browser window with the address bar indicator.
Using InPrivate Filtering

Many Web pages use content providers, or third-party Web sites, to collect information about your browsing habits. As content providers learn more about you, they can use that information to send you targeted advertisements or to personalize the products they display on the Web page.

Some consider these practices an invasion of privacy. To give users a choice in what content is delivered to third-parties, Microsoft developed InPrivate Filtering. InPrivate Filtering analyzes the Web sites that you visit. If it finds the same third-party Web sites providing content across the sites that you visit, it will block information sent to those third-parties.

In this lesson, you will learn how to turn on InPrivate Filtering and change its settings.

Turn on InPrivate Filtering

By default, InPrivate Filtering is turned off. To turn it on, follow these steps.

1. Click the Safety button in the Command Bar and select InPrivate Filtering.

   The InPrivate Filtering dialog box appears. There are two options here:
   - **Block for me**: Internet Explorer 8 blocks all content providers from receiving information about the Web sites you visit.
   - **Let me choose which providers receive my information**: Takes you to InPrivate Filtering settings where you choose which content providers to block and which to allow.

   **Trap**: The InPrivate Filtering dialog box only appears the first time that InPrivate Filtering is activated.

   **Other Ways to Turn on InPrivate Filtering**: Press <Ctrl> + <Shift> + <F>.

2. Choose an InPrivate Filtering option.

   InPrivate Filtering is enabled. A checkmark appears next to InPrivate Filtering in the Safety menu to show that it is turned on.

   **Trap**: Turning on InPrivate Filtering may disable some or all content from certain Web sites. If you find that you cannot use a Web page after enabling the filtering mechanism, disable InPrivate Filtering and try again.

---

**Exercise**

- **Exercise File**: None required.
- **Exercise**: Turn on InPrivate Filtering. Visit several Web sites. Open the InPrivate Filtering settings to see if any content providers are attempting to track your browsing habits.


Safe Web Browsing

**Tip:** To disable InPrivate Filtering, click the Safety button on the Command Bar and select InPrivate Filtering.

**Change InPrivate Filtering settings**

InPrivate Filtering may interfere with some of your Web-based activity. In this case, you may have to change the settings.

1. Click the Safety button in the Command Bar and select InPrivate Filtering Settings.

   The InPrivate Filtering settings dialog box appears. You have three options:

   - **Automatically block:** Blocks all information that might be shared with content providers.
   - **Choose content to block or allow:** Blocks only the content providers that you choose. When you select this option, you have to click each of the content providers listed and the window and indicate whether you want to allow or block their content.
   - **Off:** Disables InPrivate Filtering.

2. Select an option and click **OK**.

   The InPrivate Filtering settings you chose are enabled.
Safe Web Browsing Review

Quiz Questions

31. What is the purpose of the SmartScreen Filter?
   A. It helps protect you from threats like phishing and downloading malicious software.
   B. It makes Web pages more printer friendly.
   C. It helps protect you from mediocre and idiotic Web sites whose contents would severely insult your intelligence.
   D. It blocks advertisements from appearing in Internet Explorer.

32. Which feature of Internet Explorer is designed to help you identify forged Web sites?
   A. Print preview
   B. The Pop-up Blocker
   C. The Information Bar
   D. Domain highlighting

33. If a pop-up window or download is blocked, you can override the action and continue the download from the Information Bar. (True or False?)

34. The Pop-Up Blocker cannot be turned off. (True or False?)

35. You can allow pop-ups to appear from a Web site by adding it to the Allowed Sites list. (True or False?)

36. In which of the following ways can you open an InPrivate Browsing session?
   A. By using the key combination <Ctrl> + <Shift> + <P>
   B. By clicking the Safety button on the Command bar and selecting InPrivate Browsing from the menu.
   C. By opening a new tab and clicking Open an InPrivate Browsing window.
   D. All of the above

37. InPrivate Filtering is designed to prevent content providers from collecting information about your browsing habits. (True or False?)

Quiz Answers

31. A. The SmartScreen Filter helps prevent you from going to Web sites that might be a threat to you or your computer.

32. D. Domain highlighting works by highlighting the domain name of the Web site that you are visiting, so you know if you’re on www.microsoft.com or www.microsoft.fake.com.

33. True. You can overrule a blocked pop-up window or download and proceed with the action.
34. False. The Pop-Up Blocker can be turned off, but you'll probably want at least a low level of filtering instead of turning it off altogether.

35. True. Pop-ups will always appear for Web sites on the Allowed Sites list, regardless of the filter level.

36. D. All of the methods listed will open an InPrivate Browsing session.

37. True. InPrivate Filtering blocks information about your browsing habits from being sent to third-parties.